
AS123963 

BIMteriors – Revit for Interior Designers 
Matt Dillon 

Applied Software 

 

 

Description 

Revit is highly tuned for Architects, MEP and Structural Engineers, but "out of the box" it does 
not quite meet all of the needs and unique workflow requirements of some other disciplines, 
such as Interior Design. This class will explore some of the ways that Interior Designers can 
successfully incorporate Revit into their workflows, understanding when it is important to model 
and when it is better not to model, documenting materials and finishes, including utilizing Area 
Plans and Key Schedules, note blocks and note tags, as well as techniques for quickly and 
easily generating graphics for presentations. 

 

Speaker 

Having been a registered architect, Matt Dillon has nearly 30 years of experience in Autodesk 
Architectural applications, and is an Autodesk Certified Instructor at an Autodesk Authorized 
Training Center. In addition to assisting customers implement Building Information Modeling 
(BIM) and Revit Platform products, Dillon has also consulted with Autodesk, Inc., development 
staff in product design and usability for AutoCAD Architecture software. A published author, 
Dillon was one of the recipients of Autodesk's Distinguished Speaker Award in 2010, and he 
has been a highly-rated instructor at Autodesk University since he first began presenting in 
2000. 

  

Learning Objectives 

• Determine when to model and when not to model  

• Use Area Plans, Key Schedules, Note Tags and Note Blocks to document 
materials 

• Modeling techniques for high-end interior spaces  

• Quick and easy presentation techniques 



Introduction 

Revit is an extremely powerful and effective BIM authoring tool for Architects, MEP Engineers 
and Structural Engineers. It is also gaining acceptance in the Interior Design community, and 
adoption rates are increasing. However, there are unique aspects of the Interior Design 
workflow and deliverables requirements that Revit does not adequately address “out of the box”.  
Interior Designers wanting to be successful and profitable using Revit need to be willing to first 
consider changing some aspects of their workflow, and be prepared to modify existing Revit 
content and add additional custom content to make it more suitable for use in an interior design 
project. 

In addition, many times an interior design project is being done in the context of a linked 
architectural model, which presents additional challenges for modeling and documenting 
materials and finishes. 

In general, there is no single “right way” to deliver an interior design project. Your methods will 
be based on a variety of factors: staff proficiency, context, and level of design required are just a 
few things that will need to be considered. 

To Model or Not to Model 

BIM does not necessarily mean that everything needs to be physically modeled in a project. 
What is important is the information. While information can and will certainly be included in a 3D 
model, it can also be included in a project in other ways and conveyed just as effectively to 
deliver a successful interior design project.  

In general, major architectural elements, especially walls, doors, windows, etc. need to be 
modeled, although you can get away without modeling even those in some cases.  

 
A ”hybrid” project. Only elements that are part of the scope of work for the Interior Project are modeled 
in Revit. 



In the preceding image, a tenant finish-out project was started with an existing 2D CAD file, 
which was linked into the Revit project. Only those architectural elements pertaining to the 
tenant improvements were modeled. Most of the shell and core were left as-is, with Room 
Separation Lines used around the exterior shell where rooms will need to be defined to 
complete the room boundaries. 

The decision as to model something or not will depend on a number of factors, but some of the 
more critical things to consider are: 

• Are you working with a linked Architectural model? If so, modeling in context, while not 
impossible, will be much more of a challenge and more time-consuming. 

• Do you need to render it? Anything that needs to be rendered must be modeled. 

• Do you need to quantify it? If you want Revit to count something, it must be modeled. 

Documenting Materials and Finishes 

Just as important as the geometry, whether modeled or not are the finishes and materials. 
There are a multitude of options for documenting them. 

Spaces and Rooms 

Rooms are a key component in a typical Revit workflow for documenting finishes. The default 
properties for rooms include basic finish parameters, however these are not sufficient for most 
Interior Design needs. To make them more useful, additional finish parameters can be created 
relatively easily. 

 
The default room finish parameters. 

When you create new parameters, you need to first decide if they need to be included in a 
schedule or a tag. If they just need to be included in a schedule and not in a Room Tag, then 
you can simply add them to your Room Finish Schedule as you create it. They will immediately 
become available as properties for the rooms, and will be made Project Parameters, which can 
be reported in a schedule, but cannot be used in tags. 

 
Creating a custom finish parameter as a Project Parameter. 



If you need your custom parameters to be used in a room finish tag as well, then you need to 
make it a Shared Parameter, using the following process: 

1. From the “Manage” tab of the ribbon, click Project Parameters. 

2. In the Project Parameters dialog, click Add. 

3. In the Parameter Properties dialog, toggle on “Shared Parameter”. 

4. Click Select. 

5. In the Shared Parameters dialog, navigate to the Parameter Group that contains 
your room finish parameters, or edit the Shared Parameter File to create them, then 
select them. 

6. Back in the Parameter Properties dialog, make sure to place a check mark next to 
“Rooms” in the Categories list on the right side of the dialog. 

7. Click OK to return to the Project Parameters dialog. 

Repeat steps 1 through 7 until you have all the parameters you need for your room finishes and 
then add them to the schedule. 

 
Creating a Shared Parameter for a Room Finish Schedule so that it can be used in both a schedule 
and a tag. 

Working with a Linked Model Using Spaces 

If you are working in a project that has the architectural model linked into it, you may run into 
more challenges with rooms. While you can certainly create rooms using the walls in the linked 
model as room bounding elements, you will find it difficult and sometimes frustrating to keep up 
with changes that the architect may make to the corresponding rooms in their model. For 
example, changes to room names and room numbers can be difficult and time consuming to 
keep up with. A solution for this dilemma is to use spaces instead of rooms in your Interior 
Design Model.  



Spaces are intended to be used by MEP Engineers in place of rooms. They have data attached 
to them that is useful in the calculation of lighting levels, electrical loads and heating and cooling 
loads. They don’t have typical room attributes, such as finish parameters. Before using spaces 
to serve as “rooms” in your interior design project, you should create the custom finish 
parameters that you will need, using the same steps as those outlined previously for room finish 
parameters.  

Note: Any custom finish parameters that you intend to use, whether they are for rooms 
or for spaces, and whether they are Project Parameters or Shared Parameters, should 
be pre-defined in your Revit Project Template (along with your Finish Schedules) to 
ensure consistency and to avoid having to re-create them for each project in the future. 

Once you have your Finish Parameters defined for your spaces you need to make the linked 
Architectural model room bounding (you’ll need to do this whether you are using rooms or 
spaces). Select the link, and in the Properties palette, click Edit Type. In the Type Properties 
dialog, place a check mark in the box next to “Room Bounding” and click OK. 

 
Making a linked model room bounding. 

To place your Spaces, from the Analyze tab of the ribbon, click Space. You can either place 
your spaces manually, or use the Place Spaces Automatically tool on the next ribbon that 
appears. 

 
Placing Spaces. 

Initially the spaces will not have names and room numbers to match the rooms in the underlying 
linked Architectural model, as shown in the following image (the architectural model is shown 
half-tone). However, you can use the Space Naming tool to automatically match any spaces 
that have a corresponding room in the linked model. 



 
Using the Space Naming tool to rename and renumber all spaces in a project to align with 
corresponding rooms in the linked model. 

Once your spaces are in place and your parameters defined, you can use them just like rooms. 
You can create a space tag that reflects the room finishes, and your “Space Schedule” can 
serve as a Room Finish Schedule. If the underlying room names and numbers change at some 
point in the future, simply use the Space Naming tool again to update your spaces. 

 
Using Spaces to document room finishes. 

Note: If you are using Revit 2016 or earlier, the Space Naming tool is an add-in program 
that must be downloaded and installed from https://accounts.autodesk.com. Sign in with 
your Autodesk user ID, and follow the links to “Product Enhancements”. 



Key Schedules 

Key Schedules are a special type of schedule that allows you to schedule elements that don’t 
physically exist in your model. In an architectural project, for example, most people would not 
bother to model door hardware. A Key Schedule can be used to create a Door Hardware 
Schedule, which in turn can be linked via a “key” to the Door Schedule. In an interior design 
project, the same functionality can be used to expedite the assignment of finish parameters to a 
room, or to create a finish schedule that provides more explicit details on the finishes being 
assigned to a room. 

Using a Key Schedule to Expedite the Assignment of Finish Parameters 

Note: The following process will only work with Project Parameters or the default 
properties that already exist for rooms and spaces. Shared Parameters cannot be used 
in a Key Schedule. 

If your project has several rooms that all have the same finishes, for example, a hospital, hotel, 
retirement community, etc. you can use a Key Schedule to define finish palettes that can be 
assigned to the rooms that have common finishes, speeding up the task of assigning finish 
parameters to the rooms.  

To create a Room Finish Palette Key Schedule, use the following process: 

1. Create a new Schedule. In the New Schedule dialog, select either “Spaces” or 
“Rooms” from the category list, depending on which you are using to document your 
finishes. Select “Schedule Keys” on the right side of the dialog and change the “Key 
Name” value to “Finish Palette”. Click OK. 

 
Creating the Finish Palette Key Schedule. 

2. In the Schedule Properties dialog, click the New Parameter button. In the Parameter 
Properties dialog, note that “Project Parameter” is selected and you cannot select 
“Shared Parameter”. Provide the parameter name and make sure the “Type of 
Parameter” value is set to “Text”. Click OK. 



 
Creating a Project Parameter for a Key Schedule. 

Note: If you already have finish parameters created that are based on Shared 
Parameters they must be deleted. They cannot be re-used in your Key Schedule, and 
will cause a naming conflict with any new Project Parameters that you create. 

3. Repeat Step 2 until you have created all your finish parameters. 

4. In the “Formatting” tab of the Schedule Properties dialog, change the “Heading” 
value for the “Key Name” parameter to “Palette”. Click OK. 

5. In the new Key Schedule, which should be empty, click the Insert Data Row tool on 
the “Modify Schedule/Quantities” tab of the ribbon. A new empty data row will be 
added to the schedule. 

6. Enter the desired values for the columns in the data row, and continue adding data 
rows until you have all the room finish palettes that you need. 

 
The completed Room Finish Palette Schedule. 

Next, you need to create the Working Room Finish Schedule. This is a normal schedule and is 
the one that will be used to enter the values, but will not be the one that is actually plotted. To 
create it, simply create a new Room or Space Finish Schedule. You will find that the parameters 
that you created for the Key Schedule will be available, as they have become properties for your 
Rooms or Spaces. You will also find the “Finish Palette” parameter available as a property for 
rooms or spaces. Make sure to add that to your schedule as well. Once the schedule has been 



created you can use the “Finish Palette” property “drive” the rest of the finish properties if you 
want, or you can simply ignore it and enter the values individually when necessary. 

 
The Working Room Finish Schedule 

Finally, duplicate the Working Room Finish Schedule to create the final Room Finish Schedule. 
Remove the “Palette” column from the Room Finish Schedule so that it will not appear on plots. 

 
The plotted Room Finish Schedule, reformatted, with the “Palette” column removed. 

Using a Key Schedule to Provide More Finish Details 

Interior design projects frequently require much more discreet and detailed information 
regarding finishes. In addition to a Room Finish Schedule, a more detailed Finish Schedule is 
required to further describe the finishes specified in the Room Finish Schedule and elsewhere. 
Again, a Key Schedule can be used to accomplish this. 

 
A Key Schedule used to create a Finish Schedule. Note the use of Multi-Line Text parameters for 
some of the fields. 



Unfortunately, there are some cells, data and graphics that just cannot be included in a 
schedule, even in a Key Schedule. In those cases, you might be able to use a Legend View to 
generate the graphics that you need. While it may be “low-tech” it will frequently get the job 
done. 

 

A Legend View combined with a Key Schedule on a sheet to provide the additional formatting and data 
that could not be accommodated by the Key Schedule alone. 

Area Plans for Floor Finishes 

Area Plans are useful for a variety of things besides just documenting areas. In the context of an 
interior design project, you can use them to graphically designate floor finishes and to calculate 
the areas of those finishes, without actually modeling them. 

To create an Area Plan, do the following: 

1. Create any parameters (such as the material name) necessary for the areas that you 
are going to draw to represent your floor finishes. These should be Shared 
Parameters if you intend to use them in an Area Tag. 

You need to create a new Area Scheme for your Floor Area Plans. Areas can only be shown in 
an Area Plan, and Area Plans are based on a unique Area Scheme. 

2. From the “Architecture” ribbon tab, click Room & Area to expand the drop-down 
menu, then click Room and Volume Computations. In the Area and Volume 
Computations dialog, create a new Area Scheme named “Floor Finishes”. Click OK. 

 
Creating a new Area Scheme. 

Note: There is really nothing to edit about an Area Scheme, you just need to create the 
new scheme to associate your plans with. 



3. Create your Area Plan. From the “Architecture” ribbon tab, click Area Plan under the 
“Area” tool. In the New Area Plan dialog, set the “Type” to the “Floor Finishes” Area 
Scheme you created in the previous step. Click No in the next dialog box – you will 
be creating all Area Boundaries manually.  

 
Creating an Area Plan 

Once the Area Plan has been created, you can use the Area Boundary tool to create the lines 
defining the floor finish areas in your Area Plan. When you create the Area Boundary Lines, 
make sure that you have “Apply Area Rules” turned off in the Options Bar. 

 
Creating Area Boundary Lines. 

Note: The “Apply Area Tools” option will be on by default every time you pick the Area 
Boundary tool on the ribbon, regardless of what its setting was the last time you used it. 

A few tips to remember when creating the Area Boundary Lines: 
• Area Boundary Lines can be drawn quickly with the “Pick Lines” tool, picking along the 

edges of walls. The lines do not have to come to clean intersections. Revit is extremely 
forgiving when it comes to Area Boundaries, and they do not have to be perfectly closed. 

• Again, don’t forget to toggle off the “Apply Area Rules” option when creating Area 
Boundary Lines. 



• The Area Boundary Lines, by default, are colored purple and are rather thick. Consider 
leaving them this way when you are creating your boundaries – it makes it easier to see 
where you have created them already and where you haven’t. You can override them 
after creating the Areas themselves to be more acceptable for plotting. 

 
Area Boundaries created – the thickness of the lines is exaggerated for this image. 

Once the Area Boundaries have been created, use the “Area” tool on the Ribbon to create your 
Floor Areas. 

Tip: To make it easier to work with your Areas, turn on the “Interior Fill” and “Reference” 
sub-categories of the Area category in Visibility/Graphics Overrides. 

 
Floor Areas placed. 

In the preceding image all of the floor areas have been placed. Spaces/Rooms have been 
turned off. The tags are the default Area tags that come with Revit, and the Areas have been 
named to correspond with the underlying Space/Room names. The Floor Finish properties have 



also been filled in, but are not showing in the tags. The next few steps will make the plan more 
suitable for use as a Floor Finish Plan: 

1. Turn off the “Interior Fill” and “Reference” sub-categories of the “Areas” category in 
Visibility/Graphics Overrides. 

2. Use Visibility/Graphics Overrides to change the color and line weight of the Area 
Boundary Lines to something more suitable for plotting. 

 
Overriding the display of Area Boundary Lines. 

Next, replace the default Area Tag with a custom tag that displays the “Floor Finish” value. To 
create a custom tag, do the following: 

1. From the “File” menu, select New -> Family. In the New Family – Select Template 
File dialog, navigate to the “Annotations” folder and choose the “Generic Tag.rft” 
family template and click Open (there is no template for an Area Tag family). From 
the ribbon, click the Family Category and Parameters tool and change the category 
to “Area Tags” and click OK. Make sure to delete the red note that is on the screen. 

 
Starting a custom Area Tag family. 



2. From the “Create” ribbon, click the Label tool. After setting the justification and other 
options (such as the label type, which will determine the font and text size), pick a 
point where you want the label placed. The intersection of the two green reference 
planes on the screen represent the insertion point for the family. 

 
Placing a Label. 

3. After picking the location for the label, in the Edit Label dialog, click the Add 
Parameter button in the lower left corner. In the Parameter Properties dialog, click 
Select. In the Shared Parameters dialog select the Floor Finish parameter that was  
created for Areas (the same one that was created for your project earlier) and click 
OK until you return to the Edit Label dialog. Make sure the new Floor Finish 
parameter is selected and pick the green arrow to add it to the label. Provide a 
sample value and click OK. 

 
Specifying the Label properties. 

The label should now be placed in your family. Continue to add additional labels if desired, and 
any graphics that you might want to accompany the label.  

4. Save the family as “Floor Finish Area Tag.rfa”, then click the Load Into Project and 
Close button on the ribbon. In your Area Plan, press the <ESC> key to cancel 
placement of the tag. 

 
Loading the family into the project. 



5. Select one of the Area Tags in your Floor Finish Area Plan. Right-click and from the 
menu, choose Select All Instances -> Visible in View (this will select all instances 
of that specific type of tag in the current view). In the Properties palette change the 
Family and Type to “Floor Finish Area Tag”. 

 
Changing the Area Tags to the new family and type. 

Finally, you can create a color fill scheme and apply it to your view, along with a label to 
graphically represent the various floor finishes. In the Properties palette, click the button next to 
“Color Scheme”. In the Edit Color Scheme dialog, rename the existing “Schema 1” or create a 
new scheme and assign the “Color” field to the Floor Finish property as shown below. Enter a 
title for the finish label, then adjust the colors and fill patterns for the desired appearances and 
click OK. 

 
Creating a Floor Finish color scheme. 



Finally, you can finish your Floor Finish Plan off with the legend. From the “Annotate” ribbon tab, 
click Color Fill Legend and place the legend somewhere on the Area Plan as shown in the 
following image. 

 
The finished Floor Finish Plan. 

If necessary, you can also create an Area Schedule using the Floor Finish scheme to calculate 
square footages and other values from the Floor Area Plan. 

Note Blocks for Finish Notes 

Note Blocks provide a low-tech, but very flexible and easy to use way of keynoting materials 
and finishes in either plan, section or elevation. In addition to the Note Block, which is a type of 
schedule, you will need a Note Tag. The process for creating the Note Tag is similar to that for 
creating the Finish Area Tag: 

1. From the “File” menu, click New->Family. In the New Family – Select Template File 
dialog, browse to the “Annotations” folder, choose the “Generic Annotation.rft” file 
(NOT the “Generic Tag.rft” file) and click OK. 

 
Choose the “Generic Annotation.rft” template to create a Note Tag family. 



2. Delete the red note that is near the intersection of the two reference planes (that 
intersection, as with the Generic Tag families, designates the insertion point of the 
family). 

3. Place a label using the Label tool on the “Create” ribbon. After picking the location 
for the label, in the Edit Label dialog box, note that there are no existing parameters 
to choose from. Click the Add Parameter button in the lower left corner. 

4. In the Parameter Properties dialog, create a new Family parameter. Name it “Note 
Number”, ensure that it is “Instance” based, and set the “Type” value to “Text”. Click 
OK. 

5. Use the same procedure to create a “Note Text” Family parameter that is also 
“Instance” based and a “Text” type. 

6. In the Edit Label dialog, add the “Note Number” parameter to the label. Do NOT add 
the “Note Text” parameter. Click OK. 

7. Add any additional graphics that are needed to make the tag look the way you want. 

 
Creating a Note Tag family. 

8. Save the family as “Finish Tag.rfa” and use the Load Into Project and Close button 
to load the tag into your project. Hit the <ESC> key to cancel placement. 

9. Navigate to a room in your Finish Floor Plan and place the tag by picking the 
Symbol tool from the “Annotate” ribbon. As you place the Finish Tag in the room, 



indicate in the Options Bar how many leaders that you want. After placing the tag, 
move the leaders to the desired location.  

The tag will be empty and the leaders will not have any arrowheads on the leaders. 

 
Placing a Finish Tag. 

10. Select the tag, and in the Properties palette, click Edit Type. In the Type Properties 
dialog, change the “Leader Arrowhead” value to the desired arrowhead or pointer 
type, then click OK. In the Properties palette again, provide values for the “Note 
Number” and “Note Text” properties. 

 
Finalizing the Finish Tag and providing values for the Note Number and Note Text. 

Note: Since Generic Annotation Symbols are simple 2D objects with absolutely no 
association to anything in the model, they can be used in virtually any orthogonal view. 

Once you have your Finish Tag working, the only thing remaining is to create the Note Block, 
which is a type of schedule.  



11. From the “View” ribbon tab, click Schedules->Note Block. In the New Note Block 
dialog, choose the Finish Tag and give the Note Block a title, then click OK. In the 
Note Block Properties dialog on the “Fields” tab add the “Note Number” and “Note 
Text” parameters to the Note Block, then in the “Sorting and Grouping” tab, change 
the “Sort by” property to “Note Number” and uncheck “Itemize every instance” at the 
bottom of the dialog. Click OK to finish the Note Block. 

 
Creating the Note Block. 

By unchecking “Itemize every instance” you are making sure that only one entry per note 
number is shown in the Note Block. There are a couple of other things to be aware of: 

• It is very easy to accidentally create more than one instance of a note number, but with 
different values for the note text. When this happens, the value under “Note Text” in the 
Note Block will appear blank. To fix it, simply turn on “Itemize every instance” in the 
“Sorting and Grouping” tab. Locate the erroneous entries and correct them by either 
adding a new note number for them or matching the note text to the other values 
associated with the note number. When done, turn on “Itemize every instance” again. 

• The same Note Block can be placed on multiple sheets. If you want each sheet to have 
a unique Note Block, use an additional parameter in the Finish Tag. Create a “Sheet” 
parameter that is a text property and instance-based. Leave it blank as you are adding 
the Finish Tags, but once you place a view with Finish Tags on a sheet, select one of the 
tags, right click and use the Select All Instances -> Visible in View tool to select all 
instances of that tag in the view. Change the “Sheet” value to the sheet number of the 
sheet the view is on. In the Note Block schedule, use the “Filter” tab to include only the 
Finish Tags whose “Sheet” value matches the sheet that the Note Block will be on. 
Create as many duplicates of the Note Block with different “Sheet” values for the filter as 
you need. 



 

Material Properties and Tags 

All of the previous documentation techniques can be used whether you have chosen to model 
your finishes or not, and whether or not you’re working with a linked Architectural model. If you 
choose to model your finishes using some of the techniques in the next section, however, you 
can also take advantage of the intelligence that is built in to a Building Information Model by 
leveraging the Material Definitions in Revit. 

Material Definitions include an “Identity” tab, which contains information about a material such 
as the description, manufacturer, cost, etc. In the following image, the default Material Tag was 
used to tag the materials that were applied to the wall and the casework families. The Material 
Definitions have a “Description” property that populates the tag when filled out. 

 
Using the Material Definition’s “Description” property and the default Material Tag to annotate materials 
that are applied to model geometry. 

Custom Material Parameters 

You can create your own Material Tag with your own parameters as well if you like. You will 
need to start with the “Generic Tag.rfa” template file and re-categorize it as a Material Tag. If 
you need custom parameters, use the Project Parameters tool on the “Manage” tab of the 
ribbon and don’t forget to make it a Shared Parameter if you need for it to be used in a tag. To 
edit the custom material parameter, click the Materials tool on the “Manage” tab of the ribbon 
and choose the Custom Parameters button in the extreme lower left corner of the Material 
Browser dialog box as shown in the following image. 



 
Editing custom material parameters. 

Material Finish Schedules 

You can also create a Finish Schedule using your Material Definitions, using the default material 
properties as well as any custom Material Properties that you have created.  

1. From the “View” ribbon tab, click Schedules->Material Takeoff.  

 
Using the Material Takeoff tool to create a Finish Schedule. 



2. In the New Material Takeoff dialog, choose the category of objects for which you 
want to generate a Finish Schedule for. If you choose “<Multi-Category>”, you will be 
able to create a Finish Schedule of all materials used in the project, regardless of 
what category of objects they are assigned to. Fill in the “Name” field and click OK. 

3. In the “Fields” tab of the Material Takeoff Properties dialog, choose the 
“Material:XXX” parameters that you want in the schedule. Any custom material 
parameters that you have defined will also show up in this list. 

4. Continue to create the schedule in the same fashion as any other schedule, setting 
the “Sorting and Grouping” values (don’t forget to uncheck “Itemize every instance”) 
and the “Formatting” properties. 

If you stop here, your schedule will most likely not be correct, as it will list materials that really 
don’t belong in the schedule. Any material that is used in any way in the project will be included, 
and that will include materials that are not finish materials. To limit the materials that will show in 
the schedule, continue with the following steps: 

5. Create another custom material parameter and call it “Material Appears in Schedule”. 
Make it a “Yes/No” type of parameter. 

 
Create a “Yes/No” parameter to control which Materials appear in the Finish Schedule. 

Edit the properties of the Finish Schedule. 

6. In the “Fields” tab of the Material Takeoff Properties dialog, add the new parameter. 

7. In the “Formatting” tab, make the parameter a hidden parameter. 

 
Making the parameter a hidden parameter. 



8. In the “Filter” tab, set the “Filter by” value to only allow for those materials whose 
“Material Appears in Schedule” value is equal to “Yes” to show in the schedule and 
click OK. 

 
Filtering elements out of a schedule using a parameter 

9. Finally, edit the Material Definitions of all materials that are to be included in the 
Finish Schedule, checking the “Material Appears in Schedule” value on.  

The completed schedule should look similar to the following image. 

  
The completed Finish Schedule. 

Modeling Techniques for Interior Spaces 

If you choose to model your finishes, there are a variety of techniques that you can employ, 
depending on the situation. Keep a few things in mind before choosing to model your finishes: 

• All these techniques require working with geometry that exists in your model, not a 
model that is linked into your project. Does that mean that you can’t model your finishes 
if you are working with a linked model? No, but it will make the process quite a bit more 
complicated and is discouraged. 

• Modeling finishes can add a level of detail to your model that is more than what is 
usually found in a Revit project, and may increase the file size significantly. 

• Modeling finishes rather than simply documenting them will take much longer. You will 
need to make sure you’ve got the appropriate amount of time budgeted for your project. 

However, as stated previously, if you need to render your finishes or quantify them from the 
building model, then you’ll have to model them. 



Split Face and Paint Material 

Some firms will indicate tile patterns and other finishes with filled regions in their interior 
elevations and in plans. While this may provide the desired graphical effects, it has two major 
drawbacks: 

• The filled regions cannot be documented with Material Tags, since they don’t represent 
a true material. 

• Using filled regions unnecessarily can cause your file size to grow, with the 
accompanying performance issues. 

The Split Face and Paint tools are perfect for editing walls and floors where the finish changes, 
but you don’t want to model a separate element for each change of finish. The results can be 
documented with a Material Tag, and since any fill patterns used are part of the material 
definition itself and not a unique instance of a filled region, they have far less impact on the file 
size of your project.  

The Split Face and Paint tools are located on the left side of the “Modify” ribbon tab, in the 
“Geometry” panel. 

 
The Split Face and Paint Material tools. 

To use them to indicate different materials on the same element, do the following: 

1. Pick the Split Face tool from the ribbon, then select the face that you want to split. 

2. Sketch the split line(s). The sketch must either extend from one edge of the face to 
another, or it must be completely closed. Finish the sketch by clicking the large green 
check mark on the ribbon. 

3. Pick the Paint tool from the ribbon. An abbreviated version of the Material Browser 
dialog will appear. Select the material that you wish to paint with, then select the face 
to apply it to. You can continue to paint materials until you close the Paint tool. 

 
Splitting a wall face and painting materials. 



 
Materials painted on two faces of a wall and documented with a Material Tag. 

You can also use the Paint tool to address areas of the model that would otherwise not look 
correct when rendered. In the image below, the model on the left looks as it normally would with 
no modifications. The ends of the walls and the jambs do not show the finish materials. The 
model on the left shows the effect of using the Paint tool to apply the finish materials to those 
areas. 

 
Using the Paint tool to dress up areas of the model for rendering purposes. 

Sweeps, Reveals and Slab Edge Styles 

Wall Sweeps and Reveals can be used to add fenestrations to a wall. They can either be a part 
of the wall type itself or can be added as a separate, hosted element after the wall has been 
created. There are advantages and disadvantages to both methods. 



• Making a Wall Sweep or a Reveal part of the Wall Type definition makes it easy to 
create a wall with the fenestrations “pre-applied”. However, the sweeps and reveals 
cannot be easily edited after the fact. Since they are applied to the wall type, and not the 
wall instance, this approach can be very inflexible. Hosted sweeps and reveals, 
however, can be repositioned, added or deleted at any time without having to edit the 
wall itself. 

• You cannot apply a vertical sweep or reveal to a wall when it is embedded in the Wall 
Type. Vertical sweeps and reveals can only be added as hosted sweeps and reveals. 

• Wall Types with sweeps and reveals embedded in them can become overly complex 
and require more skill to create and modify. 

 

 
Creating a Wall Type with embedded sweeps and reveals can be extremely complex and inflexible. 

Whether you use sweeps and reveals embedded within a Wall Type or you use them as hosted 
sweeps and reveals, they must first begin with a profile definition. These are custom families 
that consist of a 2D profile that when applied as part of a sweep, get extruded horizontally or 
vertically on the surface of the wall. Sweeps will add geometry to the wall and therefore need to 
have a material assigned to them. Reveals cut geometry out of a wall. 

To add a Hosted Reveal to a wall: 

1. Make sure you have the proper Profile family loaded into your project. Wall reveals 
must be created using the “Profile – Reveal.rft” family template. 

2. From the “Architecture” tab of the ribbon, click Wall_>Wall: Reveal. In the Properties 
palette, select the desired Reveal type, or use the Edit Type button to create a new 
Reveal type, making sure to specify the Reveal profile family. 

3. Place the Reveal on the face of the wall. On the “Modify | Place Reveal” ribbon will 
be three buttons for controlling placement: 

• Horizontal – Places a horizontal reveal 



• Vertical – Places a vertical reveal 

• Restart Reveal – use this after placing a Reveal when you want to place another 
one. 

 
Tools for controlling Reveal placement. 

After placing your Hosted Reveals, you can edit them by moving them on the surface of the 
wall, or by dragging their endpoints to change their length. 

 
Adding Reveals to a wall and modifying their length. 

Sweeps are added in the same fashion, the only difference being that their profiles are created 
with the “Profile – Hosted.rfa” template and when you create the Sweep Type you should assign 
a material to it. 

While Hosted Sweeps and Reveals will handle a lot of modeling needs for wall fenestrations, 
they can still come up short in some situations, especially where more detailed modeling needs 
to be done for rendering purposes. The image below shows an example of where they may not 
be the best choice. 

 
Hosted Sweeps cannot wrap around the ends of walls or turn the corner at a jamb. 



Sweeps will stop at the ends of walls and at openings. They cannot be made to wrap around the 
corners in those conditions. Normally this isn’t a problem, unless, again, you are wanting to 
render the view and the greater level of detail is required. In those situations, as a workaround, 
you can use Model Lines (found on the “Architecture” ribbon tab), combined with Slab Edge 
Styles, which use the same “Profile-Hosted.rfa” templates that Wall Sweeps do. Draw the Model 
Lines where you want the profiles to be attached to them, then use the Floor->Floor: Slab 
Edge tool from the “Architecture” tab of the ribbon. 

 
Using Model Lines and Slab Edge Styles for more detailed corner and end conditions. 

Tip: Sometimes the Slab Edges will be placed so that their orientation is reversed. If that 
happens, use the control arrows that accompany each slab edge to “flip” it back around 
to the correct orientation. 

Using Parts 

Parts were originally developed in Revit to facilitate the workflow for Contractors, Construction 
Managers and Estimators. It allows for elements with layered construction, such as walls, floors, 
roofs, ceilings, etc. to be broken down into their individual layers and remodeled for a more 
appropriate constructability model. This feature can be leveraged by Interior Designers as well, 
to simplify the modeling of finishes and materials on complex walls, floors and ceilings. 

Using Parts, the Interior Design team can safely and effectively modify the finish elements of 
Revit elements without affecting the work of the Architectural team at all. Revit maintains two 
different versions of elements that have had parts enabled – the original, single composite 
element, and the “broken up” element with parts. Using view properties, you can display one or 
the other or both. Interior Designers can work in their own dedicated views of the project in 
which parts are visible, while the Architects can work in different views where the original 
objects are visible instead. 

Before enabling parts, then, you should create a view for them, whether it’s a 3D view, an 
elevation, section, floor plan or ceiling plan. Once you’ve created the view, set the “Parts 
Visibility” property to “Show Parts” in the Properties palette. 

 
Enabling Parts visibility in a view. 



To enable parts on an element, select the element(s) and from the “Modify” tab of the ribbon, 
click Create Parts. The element(s) will then be split into its individual layers, separating the 
finish layers from the structural, thermal and substrate layers. 

 
Converting a wall to parts. The element highlighted in red is a finish layer of the wall, which can now be 
manipulated separately from the rest of the wall. 

Parts can retain the original material assignment that was assigned to the original object, or be 
assigned a different material altogether, using the “Material By Original” property in the 
Properties palette. Assigning a different material to the part, again, has no effect on the original 
wall, which is still visible unchanged in the Architectural view. 

 
Assigning a material to a Part. 



You can also divide parts into multiple elements, each with its material assignment. Select the 
part, click Divide Parts on the “Modify” ribbon tab, then Edit Sketch to divide the part, then 
assign the desired materials to each division. 

 
Dividing the finish layer of a floor into multiple parts, then assigning different materials to them. 

Note: It may be necessary to set the current Work Plane to properly sketch on the 
surface of a Part to divide it. 

So far there has been nothing shown with parts that could not be accomplished with the Split 
Face and Paint tools. Parts, however, can also be made to have different thicknesses, and for 
that reason may be a better solution for some modeling scenarios. To change the thickness of a 
part, toggle on the “Show Shape Handles” property in the Property palette, then use the shapes 
to push and pull the face of the part to the desired thickness. 

 
Changing the thickness of a part. 



Finally, Material Tags can be used, as with materials applied using the Paint tool, to document 
the materials assigned to a Part. 

 
Tagging Part Materials. 

Modeling in Context with Linked Models 

The modeling techniques shown in this document are predicated on the model geometry being 
native in your project. If your architectural geometry is in a linked file, none of these methods will 
be available to you. While you could use the Copy/Monitor feature of Revit to copy the elements 
that you want to modify from the architectural model into your project, you would then have to 
suppress the display of the architectural model elements. This would be a very inefficient and 
error prone workflow, as you would have to be more careful to keep the two models coordinated 
and to manage changes. Instead, in those situations where your model geometry is in a linked 
model, consider limiting your processes to only the annotation tools described at the beginning 
of this document. All of them, except for the Material Tag, will work with a linked model, and you 
can use Note Blocks, as previously described to document your finishes. 

Another consideration is to work in the Architectural model directly. If you are working on the 
same LAN (Local Area Network) as the Architectural team, this is easily accomplished with 
traditional worksharing capabilities that have been available in Revit for years.  

If, however you are working with an Architectural team that is outside your firewall or whose 
model is only accessible via a WAN (Wide Area Network), then it becomes more problematic. In 
those cases, consider using a service such as Autodesk’s A360 Collaboration for Revit, which 
allows for a project’s Central File to be hosted in the cloud and accessed via Revit by anyone 
with the A360 Collaboration for Revit entitlement and who has been invited to the project. 
Before committing to A360 Collaboration for Revit, however, there are a couple of things to 
consider: 

• A360 Collaboration for Revit and its companion service BIM 360 Team are “high trust” 
environments. Someone invited to a Revit project to collaborate via Revit as an editor 
has quite a bit of permission on the site – there are limited security controls. If different 
disciplines are working in the same model, strict protocols and processes need to be 
developed and adhered to in order to avoid causing conflicts between the disciplines. 

• A360 Collaboration for Revit is not a free service. It is an entitlement that is subscribed 
to on a monthly, quarterly or annual basis. 



Quick and Easy Presentations 

While you can use advanced rendering and animation software such as Autodesk 3ds Max, as 
well as other 3rd party products, to prepare presentations based on your Interior Design project, 
if you have modeled it, you have a variety of options available to you that do not require an 
extensive learning curve, and that can in some cases be accomplished from within Revit by 
itself. 

Using Graphic Display Options 

One of the quickest and easiest ways to present an Interior Design project is to simply configure 
a Revit view using the Graphic Display Options property of the view. In addition to the basic 
Visual Styles (Wireframe, Hidden Line, Shaded, Consistent Colors, etc.), there are additional 
options to enhance the display. In the illustration below, note the difference between the 
standard “Shaded” visual style display in the image on the top and the effect of simply turning 
on “Ambient Shadows” in the Graphic Display Options dialog. 

 
Enhancing the “Shaded” Visual Style with Ambient Shadows. 



There are many settings in the Graphics Display Options dialog that can be used in various 
combinations to get a wide variety of visual effects in your Revit view: 

• Model Display 

o Style: This is the Visual Style, the same settings that are found in the View 
Control Bar at the bottom of every Revit view to control whether the model is 
shown in Wireframe, Hidden Line, Shaded mode, etc. 

o Transparency: Adjusting this slider will cause all model elements to become 
transparent. (You can also control transparency of individual objects and 
categories using Object Visibility Overrides or Visibility Graphics / Overrides.) 

o Silhouettes: Causes the exterior profile lines of model elements to become 
heavier than the rest of the line work. 

• Shadows: You can cast shadows that are a result of direct lighting, as well as show 
“Ambient Shadows”. 

• Sketchy Lines: Adjusting the “Jitter” amount will cause the lines to appear hand-drawn 
(freehand style). Adjusting the “Extension” amount will cause them to extend past each 
other at corners. Remember, a little goes a long way! 

• Depth Cueing: Useful in Elevations and Sections to indicate objects that are further away 
from the clipping plane by having them display with faded (halftone) lines. 

• Lighting: Depending on the Visual Style, you can use the same lighting schemes that are 
used for rendering. 

• Photographic Exposure: Again, depending on the Visual Style, you can adjust the 
exposure of your view to make it brighter or darker. Using Color Correction, you can also 
make a “warm” scene appear “cooler” by adjusting the White Balance, or make it look 
more subdued by adjusting the Saturation value. 

• Background: Usually more applicable for exterior scenes, you can set your background 
to simulate the sky (based on the date, time of day and location set in the Lighting 
settings), use an image, or assign a color.  

The image below is the result of using the “Realistic” Visual Style, artificial lights, Ambient 
Shadows and adjusting the Exposure Control to darken the scene slightly from the default 
settings. 

  
Using the “Realistic” Visual Display with Exposure Control to darken the image slightly. 



The image below is the same view, this time with Color Correction combined with the overall 
Exposure Control to adjust the White Balance and Saturation levels, making the image more 
grey scale and muted. 

 
Using Color Correction to “mute” the display. 

You may want to present a model without materials to direct conversation away from finishes, 
and more toward general layout and design. Using the “Hidden Line” Visual Style with other 
Graphic Display Options you can easily generate an attractive monochrome image for 
presentation. In the image below, ambient shadows have been enabled, along with sketchy 
lines. 

 
Using the “Hidden Line” Visual Style with ambient shadows and sketchy lines to create a 
monochromatic image. 



Rendering in Revit 

Generating renderings of still images in Revit can also be quick and easy, once you have a 
good understanding of a few basic rendering elements: 

• Materials: Understanding how to navigate the Material Definitions dialog and how to 
create new materials, and most importantly, understanding how to work with 
Appearance Assets, which is the rendering component of a material definition is critical 
to getting a good quality image that realistically conveys the materials and finishes in 
your project. 

• Lighting and Exposure: You will need to understand how to control the light sources in 
your project, especially artificial lights. In addition, you will need to have a basic 
understanding of exposure settings. While these are relatively simple in Revit compared 
to other rendering applications, they can have a dramatic impact on your scene. 

 
A still image rendered in Revit. 

Cloud Rendering 

One downside to rendering in Revit is that a good quality image may take some time to 
generate, tying up your Revit session while the rendering is being processed. Using Autodesk’s 
A360 Cloud Rendering service you can offload the rendering task, allowing you to continue 
working while your rendering is being processed in the cloud. In addition to the benefit of 
offloading the computationally intensive rendering task, it takes far less time as well. Instead of 
waiting for several minutes (or hours) for your rendering to complete, most cloud rendering 
tasks are finished in 10 minutes or less. 

Depending on the settings and options you choose, your cloud rendering may or may not 
involve spending any number of “Cloud Credits”. At the time of the writing of this paper, one 
cloud credit equals $1.00 U.S. When your Autodesk Account is initially created, you are 
automatically granted several Cloud Credits at no additional charge. Once you have used those 
up, you can purchase more. 

When you initially send your image to the cloud for rendering, choose the lowest quality settings 
available, as these will not use any cloud credits. Once the image has been rendered you can 



choose to re-render it with more advanced settings, however you may decide that the 
“Standard” image quality is sufficient for your needs.  

 
Sending a render job to the cloud as a “Standard” quality still image, which uses no credits. 

If you decide that the image quality needs to be better, you can re-render it with new settings, 
which again, may or may not incur the expense of one or more cloud credits. 

 
Re-rendering a cloud rendering with more advanced settings. 

With cloud rendering, however, you can do more than generate still images. Among the other 
types of images available are Panoramas and Stereo Panoramas (for viewing with virtual reality 



goggles such as Google Cardboard). You can also generate Illuminance images, which, while 
certainly not presentation quality, will provide insight as to lighting levels in a space. 

 
A panorama and illuminance image generated with A360 Cloud Rendering. 

For examples of a panorama image and a stereo panorama image rendered with the A360 
Cloud Rendering service, use the following links: 

Panorama image: 

http://pano.autodesk.com/pano.html?mono=jpgs/efd1ae89-3790-4afa-b541-a515d9ae7917 

Or scan the QR code below with your smart phone: 

 
 

Stereo Panorama Image (view with VR goggles on your smart phone or with a VR headset): 

http://pano.autodesk.com/pano.html?url=jpgs/09505d4d-f175-4a86-8694-3d3d0bf4f424 

Or scan the QR code below with your smart phone: 

 
 



Revit Live 

For a more immersive experience, you can generate a Revit Live file, which can be used to 
interactively walk through your project. Revit Live is an additional cloud service which can be 
subscribed to on a monthly, quarterly or annual basis.  

Creating a Revit Live file is amazingly simple. After installing the plugin for Revit, simply click the 
Go Live button on the “View” ribbon tab. Once the Revit Live file has been prepared, it will be 
downloaded to your computer, and you can edit, create and delete pre-saved viewpoints in the 
Revit Live editor. The Revit Live file can be viewed on a free Live Viewer that is downloadable 
from Autodesk. There is also a free viewer available in beta form for the iPad Pro. 

Using the Live Viewer, you can not only view the model, but you can also view the Revit 
properties of the objects in the model. 

 
Using the Live Viewer to walk through a model and to view Revit properties of model elements. 

Summary 

As stated in the opening paragraphs of this document, there is no single “right” way to deliver an 
Interior Design project with Revit. The tools and methods used will depend on the context that 
the project is being developed in, and the constraints of the various inputs. For example, are 
you working with a linked Architectural model, or are you working natively in the Architectural 
model? If the former, your modeling will most likely be much more limited. There are a variety of 
effective tools for documenting and presenting materials and finishes, regardless of the project 
limitations and constraints. Choose those that work the best for your particular workflow and 
deliverables needs and develop them. You will most likely need to consider changing some of 
your typical deliverables and standards to get the most benefit from Revit. 

Finally, whatever tools you choose to use, make sure to include any standard content, including 
annotations, schedule views, view types and templates, critical modeling content such as 
profiles, sweeps and reveals, in your Project Template so that you are not having to “re-invent 
the wheel” with each project.  


